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Laboritoo 7

Koostu monteerimine, 1 ; Exploded View

Opitavad piadevused:

Detailide monteerimine loogiliselt ithendatud siisteemideks — koostudeks.
Erinevat tiiiipi seosed koostu komponentide vahel. Uhilduvus ja kontsentrilisus.
Detailide liigutamine koostus.

Modelleerimise abildiked

Alakoostu loomine ning lisamine pdhikoostu

Koostu 16hutud vaate loomine — Exploded View

Tiikitabeli loomine

Teadmiste ja oskuste kontroll :

Demonstreerida koostu monteerimise pohietappe.
Tutvustada erinevat tiiiipi seoseid.

Lohutud vaate (Exploded View) valmistamine
Detailide tidhistamine joonisel (Auto Balloon)
Tiikitabeli loomine

Koost on mitmest iiksikust detailist koosnev ning omavahel loogiliselt seostatud detailide
siisteem. Koostu loomise eelduseks on, et meil on olemas vastavad valmisdetailid. Jargmistes
laboritoddes vaatame lisaks detailide loomist koostu monteerimise kdigus.

1.1 Koostu modelleerimine

o Koostu modelleerimiseks tuleb

SolidWorksi dialoogi aknast valida
koostu montaazi funktsioon -

(File -> New -> Assembly).

&

a 3D representation of a single design component

a 3D arrangement of parts andjor other assemblies

N Azsembly

Avanenud keskkonnas on voimalik
eelnevalt joonestatud detailid omavahel Drawing
seostega ihendada, luues nii ,,lihtse

terviku®, mille abil on vdimalik hiljem

1@

a 2D engineering drawing, tvpically of a part ar assembly

. . [ [s]4 ] [ Cancel ] [ Help
luua koostejoonis. . .. L
Joonis 1: Koostu montaazi funktsiooni
sisenemine
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1.2 Puurimisabinou koostu modelleerimine

Eelnevalt valmis loodud puurimisabindu detailid:

e Alusplaat

e Kaas

e Poldipea

e Kinnituspolt
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e Puks

e Vaheplaat

e Stopper

%" Insert Component

V) ®) D)

rt ar assembly ko insert
ace the component in the

1 . Use thi h pir &
Vahda B rowse Iz c0|s:?es oefptuhfa sglrl:neoor
nuppu kasutades ™"

ion ko insert a component

alusplaadi detail

documents:

Insert Cormponent h

Browse, ..

Start command when
creating new assembly

Graphics presisw

Koostu monteerimine, 1

o,

Sketch

Raalprojekteerimine 1

Solidworksi FeatureManageri aknasse
ilmub jdrgnev valik, mille kaudu on
voimalik koostu sisestada uusi detaile.

Funktsioon leidub ka CommandManageri
tooriistahalduri

@ (%
Features T  “hect Wszemblies ’ HideiShow
fetal k Compane., !

Esmalt ennem detaili lisamist tuleb
nihtavaks teha koostu alguspunkt -

View -> Origins

Jooniseviljale kuvati kordinaatide
alguspunkt.
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TAHELEPANEK - Eelnevates laborites rdhutati, et alati tsentreerida kujutise loomine juba
algusjdrgus keskpunkti suhtes! See teeb koostu loomise tunduvalt lihtsamaks ning lubab luua
vihemate seostega toimiva tdisvaartusliku koostu.

e Valida baas kujundiks alusplaat ning paigutada ta kursori abil joonisevilja kordinaatide
alguspunkti.
e Jitkata koostu loomist, lisades joonisele vaheplaat (/nsert Component).

e Alustame koostu kokkumonteerimist kasutades SolidWorksi MATE (seosed). Valime
alusplaadil tihe ringikujulise serva ning samuti ka vaheplaadil (Ctr/ nupu abil).

e Kasutada CommandManageri tooriistahalduris paiknevat Mate funktsiooni -
® B & @ T ®» 8 ¥

) o
Treett  Hide/Show  Change Edt MoEmtemal  fae Move Rotate S Evploded  Explode  Interfare...
i Rel Component Component  Fastensrs Wiew Line Sketch  Dretecti

A Caincident
\\ Parallel

L Perpendicular

é\ Tangent .
Concentric NOLIStU.da aI'Vlltl
& pakutavate

b tingimustegal!

Mate alignment:

e Seos Concentric paigutab detailide ringikujulised kehad omavahel kontsentriliselt
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e Valida joonisel niitatud pinnad ning

seostada nad omavahel Coincident seose
abil.

e Scos Concentric muudab  pinnad
omavahel tihtivaks

Standard Mates E:E

L Perpendicular

.:} Tangent
Perpendicular i
Zoncentr

C

| 31, 1084359 1mm | _ B )
Joonisel tehtud 10ige on tehtud parema iilevaate
@| 0.00deq | saamiseks, iilidpilastel pole vaja seda teostada!

Mate alignment:

e HUVILISTELE UURIMISEKS LOIKE — =
TEOSTAMINE- L@ 80 ﬁ”!ﬁ g@]

a
Srnart Expladad Explode  Int

Section Yiew

Displaws a cukaway of a park or assembly
1sing ane or more cross seckion planes,

e Jirgida eelnevalt Opitud pohimdtteid ning lisada koostu veel kaas (koik augud seada
kohakuti) ning iiksainus puks.
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° iailgtgsvalt luua abitelg alusplaadi siseava F—— )
uhtes.
Insert - Reference Geomatry - Axis - |":‘x'51 |
Cylindrical/ Conical Face A =
™ 360.00deq =
e Kasutades Linear Pattern s 4 g:

korduvelementide tooriista ,,paljundame*
pukse endale vajaliku arvu, sddstes nii
aega.
Insert -> Component Pattern — Circular
Pattern

e Salvestada  saadud  koost nimega
puurimisabindu kooste.

Equal spacing

Components ko Pattern

1.3 Puurimisabinou alakoostu loomine

e Luua uus koost (File -> New -> Assebly). Baas kehaks, millele hakkame teisi detaile kiilge
»pookima* votame kinnituspoldi.

e Secoste abil ,,ithendada“ kinnituspoldiga omavahel stopper ning poldipea.

e Juhul, kui seos Concentric veab silindriliste kehade tihendamisel alt, on voimalik seoseid
luua ka Plane vahele (luues monikord detailile ainult seostamiseks vajamineva abi Plane voi
sootuks telgi) (Joonis 1.1).

e Poldi lopptulem -
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Joonis 1.1 : Abitasandite seostamine

e Huvilised vdivad ka poldipeale luua rihvelduse (,,kareda pinna*) kasutades Linear Pattern
tooriista. Antud juhul on tegemist lihtsustatud kujutisega.
Juba tuttavate modelleerimis seoste abil, iihendada omavahel 2 koostu ning salvestada.

|
1.4 Koostu I6hutud vaade - Exploded View

e Avada eelnevalt valmistatud puurimisabindou kooste. CommandManageri tooriistahalduris
paikneb Exploded View.

H yic L& €8l

r i =) (505 s o
T h B () % E K] E&
Insart HidefShow  Change Edit Mo Extermnal Mate Mowe Rotate Srnart

Sketch 7  Features 7 Sijeet
Compone.., Cormpone,,. Suppress,,. Cormponent References Component Component  Fasteners

Ietal

Koostu monteerimine, 1 7/10



Tonu Leemet/Pearu Orusalu, EMU TE

1 Explode

@ ‘ Z@Edge<1 =@vaheplaat-1

e ‘ &0.00mm
|

[]5elect sub-4

Likumissuuna
distants

Reuse Sub-assembly .
Explode

e Vajutades Apply, tekib Exploded Steps alla esimene samm.

e Jirgmisena liigutame samas suunas vaheplaati 40 mm ning kaant 20 mm.

Alusplaadi
niitame sellele
viljale

Alusplaadi likumis
suuna maarame

selle referents
kolmiku kaudu

e 25 mm llesse poole liigutame aga loodud polti.
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Select Other

@), zoom to Fit

@1 Zoom ko Area
ClI Fonom Infout

a Raotate Yisw

l-I-b Pan

i3 Roll Yiew
% Wiew Orientation, ..

Recent Commands

e Lopptulemi saab panna ,,kokku* joonisevéljal parem click ning Collapse
e Lopptulem salvestada

1.5 Tukitabeli loomine

e Luua puurimisabindust 16hutud kujul koostejoonis ning kasutada AutoBalloon
(CommandManageri tooriistahalduril) tooriista detailidele osutamiseks, lisada samuti
SolidWorksis EMU standartidele vastav masinachituslike jooniste tiikitabel e. Bill of
Materials (Insert — Tables — Bill of Materials).

e Esmalt luua SolidWorksi poolt pakutavatele standartitele vastav kirjanurk

e Kuvamaks alakoostus loodud poldi kdiki detaile tiikitabelis mérgistada &ra tiikitabel ning
FeatureManageri alt valida jargnevad valikud -

Anchared cormer 4{% 2 B [ D
H H||E T TEA MO, PART MUMBER DESCRIPTION QTY.

2 1 alusploat 1
[ attach ko anchor it} 2 ahsplaal ]
— 4 3 Kaas 1
5 4 Polt 1
O Toplevel anly g 4. Kinrituspolt 1
() Parts anly 7 4.2 PO|C“D =18 1
(%) Indented assemblies 4.3 STopper 1
: 7 5 Puks 4

[#] Shaw numbeting
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e Ilmsalt peab uuendama Auto Balloon toodriista kasutades detailide tdhistust joonisel!

e Masinachitusliku joonise kirjanurk - EMU Tehnikainstituudi Ulidpilasttédde vormistamise

juhend
e Tabeli piise asukoha vaetamine, Tabele | Header A
Format (Ilmub FeatureManagery valides iz
suvalise veeru) -
[ Display title
Position
o=
. . e ee . it
e Tabeli laiuse midramine L et ’
5 Select 4
Z] 4.3 Delete 4
4] 4.1 Sort F.owe Height
g 4 Follaw Assembly Crder Entire Table
__},_% Split 3 I |
e Uue tulba lisamiseks tiikitabelisse, tuleb sl AT column Right
valida dra veerg ning Insert. 1] ¢ el [ el T
? A Delete L4 Ruow Abowve
a1 Formatking L4 Row Below
e Veergu valides on voimalik muuta ka
veeru nime.
Column Properties 3

2 Tkem Mumber

() Part Mumber
Quantity

O Custom Properky

O Equation

Part number:

[ use Title Summary
Title:

| Mimetus, materjal

Column position:

e Loodud tabeliformaadi saab salvestada edasiseks kasutamiseks (huvilistel uurida
iseseisvalt)!
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S Puks 4
4.3 Stopper 1
4.2 Poldipea 1
4.1 Kinnituspolt 1
4 Polt |
3 Kaas 1
2 Vaheplaat 1
] alusplaat 1
Osa|Vdali Nimetus, materjal Tahis Hulk| Markus
Materjal Méarkimata piirhdlbedMass Moot
2:1
Teostas Pearu Orusalu Nimetus
Kontr. PUURIMISABINOU LOHUTUD VAATES
Kinnitas
EESTI MAAULIKOOL Leht  Tdhis Muud

050888
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2 Kordamiskusimused
e Demonstreerida dppejouleerinevate seoste loomist
e [Exploded View loomise toovotted

e Tiikitabeli seadistamine ning oma malli loomine

2.1 Koostu esimene detail - alusplaat

Jooniste 1 ... 5 pdhjal modelleerida esimene detail. Mdodud on antud mm-tes, kasutage neid
gabariitmootudena.

50,80
|
3
~
<
‘ |
Qrz \0033 E}@3L75:_ﬂ /P@](g
s & ,
Joonis 1: Eestvaade
Joonis 2: Vaade vasakult
Rl 9.53
T o i
L T L T]I
@ 7 . FENY \%
N ©) Rt Ay e

10}
#9,53
S
Ji
3

<
) pram—d
e
Joonis 3: Pealtvaade =L 115,88 —_
g VAADE B-B
< M1

Joonis 4: Loige B-B
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Joonis 5: Koostu esimene detail

2.2 Koostu teine detail - neet

15,26

—
==

Ak -
M S
(@]
|
__ 18,74
Joonis 6: Teine detail -

neet
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2.3 Koostu kolmas detail - polt

_3.80__ %F@% s

. 5 =
2 3
o o
697 _ | &, o
=3 &
O
o}
2
p -
!
Ej Joonis 8: Eestvaade, isomeetriline vaade
f‘"l = ___%35
|
. 953 | _.

Joonis 7: Ristloige
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1.1 Teine koost

e Valime meniili File, New — Assembly. Seejirel avame kdik kolm eelnevalt loodud detaili:
alusplaadi, poldi ja needi.

£ Solidworks Student Design Kit - Academic Use Only - Assem1 ;Iilll

File Edit Yiew Insert Tools Window Help

[DeWE®2a9 ¢ kel R -srl2 2@t aaqac+d - 007@IEM |

a = [ L]
N ji2 B % < 9 S © ) B o B B
Assemblies |7 Sketch 7 Insert HidejShow  Change Edit [ate Move Rokate Srnark Exploded  Explode  Inkerfer... Features ™ Simulation ™
Compon... Comparn... SUREres... Component Component Component  Fasteners Wigw Lime Sketch - Detection

Nz Asseml M=}, lab72.5LDPRT =l
fat
- |[®5TA] B EE B
% Asseml % lab7z ﬁl
g Annotations g Annotations ()
£, 2 Design Binder [+, Design Binder
Lighting KOO S T gE Material <not specified = oS
% Front Plane L 4] Lsie] Lighting
&> Top Flane [+ @] Solid Bodies(1)
&5y Right Plane X% Front Plane
I_, Crigin Q Top Flane
@@ Mates \<§\ Right Plane ¥
L, Origin
[]...5?3 Revolvel H
-
1 :
%, lab71.5LDPRT ab DPR o [=] |
N
S5 1R SERl _/ 2
W, lab71 W, 1ab73
IE Annotations IE Annotations
M @ Design Binder []..@ Design Binder
3= Material <not specified= 3= Material <nof/specified:
[ @ Lighting []..@ Lighting
) @ Solid Bodies(1) []..{E] Solid Bogies{1)
%y Front Plane Ly
%%y Top Plane Ly
Q Right Flane Z > Rfght Plane 1
.1, rigin .1/ Crigin ii «
[].@ Extrudel [ Revalvel i
- ([} Extrudez &
[#-[@] Cut-Extrudel v =
@ ot m F

Ready \ ’// ['[ [dting Assembly [ [ 7]

DETAILID
Joonis 9: Koostu detailid

e Jirgmiseks tuleb detailid faili ,tdsta® ning seostega kokkumonteerida. Detaili koostu
lisamiseks on mitmeid vdimalusi, siinkohal votke hiirega kinni detailist FeatureManageri
kujundipuus.

e Esimeseks valime (st. [dheme kujundipuus FeatureManager kdige esimese “oksa” peale) ja
»lohistame® koostu alusplaadi. Seejérel lohistame neli neeti ning iihe poldi. Tulemus Joonis
11, detailifailid voib niitid sulgeda.

e Koostu komponendid olemas, tuleb need kokkumonteerida. SolidWorksis tehakse seda 14bi
seoste loomise — MATES. See on midagi sarnast eskiisi loomise juures olnud seoste
(relations) loomisele. Siis madrasime dra kuidas geomeetria elemendid omavahel paiknema
peavad. Niilid koostu loomisel méddrame dra kuidas peavad omavahel paiknema erinevad
detailid ja nende osad.

e Esimene seos — polt peab paiknema alusplaadi kinnitusavas. Valida Mate tooriist,

Koostu monteerimine, 1 4/6
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AssemblyFeatures tooriistahalduri alt. Avaneb PropertyManageri aken. Jargnevas tabelis on
Mate PropertyManageri tihtsamad véljad eraldi véljatoodud.

2
o 17

—

SEITSMES LABOR
Joonis 10: Koostu detailid

Tuleb  programmile  ettendidata  milliste
@ T elem_entlde (plnnad,‘ serxad) Va_hel seo.sel_d
Face<2 =@lab73-1 soovitakse luua. Meie ndites valida poldi ja
alusplaadi silindrilised pinnad.
Standard Mates - Standard seosed

Mate Selections s

P e iihildumine (coincident)
o e paralleelsus (parallel)
> | Parallel e ristseis (perpendicular)
L | perpendicular e puutuja (tangent)

e kontsentrilisus (concentric)

a\ Tangent
CorEEE Meie niites valida kontsentrilisus.
Al |

Elip Dimension

s | |

Mate Alignment:

(93] B
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Mates " Valitud elementide vahel olemasolevad seosed.

% Concentricl {lab?1 <1zl

[~
||

Pérast esimese seose loomist valige Move Component tooriist ning liritage polti liigutada.
Veenduge, et see saab litkuda ainult vertikaalses suunas — ei saa mitte kuidagi rikkuda
kontsentrilisuse nduet vastva ava suhtes.

Poldi ,,jdigaks* kinnitamiseks alusplaadile, iihildada (coincident) poldipea alumise pind ja
alusplaadi vastav pind.

Veenduda, et ei ole voimalik polti alusplaadist eemaldada.

Sarnaselt kinnitada needid.

Lopp-tulemus, Joonis 11.

Joonis 11: Esimene koost
Kas poldi voi needi kinnitamisel alusplaadile oleks moeldav paralleelsuse seose kasutamine?
Katsetage!

Kéesolevas lahenduses saab polt alusplaadi sees vabalt poorelda. Kas oskate luua seose, mis
fikseeriks poldi tdielikult?

Poorake tidhelepanu detailide vérvusele, seadke oma detailidele erinevaid varvusi. Andke
esimese koostu kujundipuus detailidele nimetused ,,alusplaat®, ,,polt“, ,,neet*.

Koostu monteerimine, 1 6/6
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